
CC Libraries



CC Libraries © Ben Willmore, All rights reserved 2

CC Libraries

In this lesson, we’re going to take a look at Libraries in Photoshop. Libraries are 
found in Photoshop, as well as InDesign, Illustrator and many other Adobe prod-
ucts, including their mobile applications. Libraries allow you to store images, 
graphics, colors, type settings and brushes so that you can access them using any 
of your devices. Libraries also allow you to share items with friends/colleagues, 
which makes them great for project collaboration. Let’s take a look at what Li-
braries are, how they work and why you probably want to be using them. If you’re 
already using them, you’ll learn some tips for getting the most out of them. 

The Libraries Panel (Timestamp: 1:09)

Your Libraries can be accessed via the 
Libraries panel in Photoshop. If the panel 
is not already open on your screen, click 
on the Window menu and choose Li-
braries. If you’ve never created a library 
before, the panel will only contain the 
default library, titled “My Library.” If you 
have multiple libraries, you can access 
them by clicking on the dropdown menu 
at the top of the panel. This menu also 
contains the option to create a new li-
brary. When creating a new library, you’ll 
be prompted to give the new library a 
name. This will open the new, empty li-
brary and you can store all sorts of things 
within it. 

The Libraries panel in Photoshop. Switch  
between different libraries by using the 
menu at the top of the panel (circled).
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Adding things to a library (1:45)

Adding the contents of a layer  You can 
save the contents of one of your layers 
to a library. With the desired layer active, 
make sure that the Move Tool is active and 
simply click and drag the contents of the 
layer into the Libraries panel. In the panel, 
the new item will appear as a little thumb-
nail, along with the name of the layer and 
the file type. 

Near the top of the Libraries panel is the 
View By menu and this give you the option 
to view by type or by group. If you don’t 
have any groups set up, set this menu to 
Type. (We’ll cover groups later.) 

Adding colors, text styles, etc.  Add dif-
ferent elements to a library by clicking the 
little plus sign in the lower right corner of 
the Libraries panel. This will pop open a 
menu that contains a bunch of things re-
lated to the layer you’re currently work-
ing on. If it’s a text layer, you can save the 
Character Style, which includes the type-
face, size, etc. You can also choose to save 
the color of the text (Character Color), the 
Foreground Color, Background Color, etc. 
If the active layer has a layer style applied 
to it, then you can choose to save that lay-
er style to the library. 

Near the top of the Libraries panel, you 
can choose to view by Group or by Type. 

Click the plus sign and a menu will appear 
that lets you add an element from the  
active layer to the library.
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Using Library Items in Another Document (4:11)

After you’ve added various items from 
one document into a library, you can ac-
cess those items while working on a dif-
ferent document. To apply a certain attri-
bute to a layer, make sure that the layer 
is active and then click on the attribute 
within the Libraries panel. For example, 
let’s say that you want to apply a saved 
layer style to the active layer. Simply click 
on the layer style item in the Libraries 
panel and it will automatically be applied 
to that active layer. If the layer is a text 
layer, you can click on a Character Style 
within the library to apply those settings 
to the text. 

You can use a saved graphic by dragging 
it from the Libraries panel directly into 
your document. When you release the 
mouse button, the graphic will be placed 
on its own layer and there will be trans-
form handles you can use to scale and position the graphic. Click the Return/
Enter key to lock in the transformation and remove the transform handles. 

How Libraries Work (5:20)

In the bottom right corner of the Libraries panel is a little Creative Cloud icon. 
When you drag an item into the panel, you’ll see that the icon will change, which 
indicates that it’s busy doing something. It looks like two arrows, spinning in a 
circular shape. This lets you know that it’s in the process of saving the item. 

Many different types of assets can be add-
ed to a library. Here, you can see that this 
library contains Colors, Character Styles, 
Layer Styles and Graphics.
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When you save something to your library, it saves a copy on your hard drive and 
it also uploads the graphics and other attributes to your Adobe Creative Cloud 
account on the Internet. It also automatically downloads those items to any other 
computers/devices that are using the same Adobe ID. (Note that those comput-
ers need to be on the Internet.)

Different Uses for Libraries (7:03)

Libraries are very useful for storing items 
you use on a consistent basis. It eliminates 
the need to search for a commonly-used 
element every time you need it. Corporate 
graphics are a good example of this. I have 
a library set up for Masters Academy, which 
contains our signature colors, fonts and 
graphics. This makes it easy to access these 
items while working on different machines. 

I also have a series of graphics that I use for 
my photographic arts. These are logo-style 
graphics that I like to place on my images, 
either as watermarks or logo stamps. I keep 
all of these in a library so that I can always 
access them from inside Photoshop, regard-
less of which machine I’m working on. 

The Creative Cloud icon ap-
pears at the bottom of the 
Libraries panel. If it changes to 
look like two spinning arrows, 
that means that it is actively 
syncing the library to the cloud.

I have a library set up for Masters  
Academy, which includes our colors, 
fonts and logos. 
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Libraries Across Multiple Applications (8:51)

What’s nice about libraries is that they’re not limited to Photoshop. You can use 
them in many other Adobe products. This means that you can create a graphic 
in Illustrator, add it to a library, and then open the Libraries panel in Photoshop or 
InDesign and drag that graphic into the document. 

The Libraries panel looks the same whether you’re in Photoshop, InDesign, Illus-
trator, etc. It can be accessed via the Window menu at the top of the interface. 

This logo was created in Adobe Illustrator and then saved to a library. Here, we are dragging 
the logo from the Libraries panel within Photoshop into the Photoshop document. 
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Libraries and Smart Objects (10:33) 

Whenever you drag a graphic from the Libraries panel into an open document, it 
places the graphic as a linked smart object. When a Photoshop layer is a smart 
object, a little icon will appear in the bottom right corner of the layer thumbnail 
in the Layers panel. If the little icon 
looks like a sheet of paper with the 
corner turned down, it means that 
it’s a normal smart object. If the lit-
tle icon looks like a link, it means 
that it’s a linked smart object that 
is linked to a file that’s stored on 
your hard drive. If the icon looks 
like a cloud, it means that it’s linked 
to some content that’s stored on 
the cloud. In InDesign, that same 
icon will appear in the Links panel. 

When working with a regular smart object in Photoshop, you can edit the orig-
inal contents by double-clicking on the layer thumbnail to open the contents 
in a separate document window. That’s not necessarily what will happen if you 
double-click on the type of smart object that has the cloud icon. When you dou-
ble-click on the smart object with the cloud icon, it’s going to open the image/
graphic in whatever program that the image was created in. In the video example, 
I double-clicked on the smart object containing a logo and it opened the logo 
in Adobe Illustrator. That’s because the logo is a vector file that was created in 
Illustrator. I can make changes to the logo in Illustrator and when I save and close 
the document, the file will update in the Libraries panel and any open documents 
that contain the logo. If there is a file that contains the logo but is not open at the 
time I made the update, it won’t automatically change when I open it. Instead, 
there will be a little exclamation point in the bottom right corner of the smart ob-
ject layer thumbnail, indicating that changes were made to the file and that the 
version that’s stored in the cloud is different than the version in the document. To 
update the file, right-click on the icon and choose the update option. 

This is the thumbnail for a smart object that was 
added to the document via the Libraries panel. The 
cloud icon indicates that it’s a smart object that’s 
stored in the cloud.
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Organizing Libraries using Groups (15:52)

Once you start accumulating a lot of graphics 
in your Libraries panel, you’ll probably want to 
start organizing them. If the menu at the top 
of the Libraries panel is set to View by Type, 
then it will be categorized by asset type (such 
as Colors, Character Styles, Graphics, etc.). To 
organize your panel in a more custom way, 
change the menu to View by Group. If you al-
ready have some groups set up, they will be 
listed in the main part of the panel. Create a 
new group by clicking the little folder icon at 
the bottom of the panel. A new group will be 
created within the panel and the name will be 
highlighted so that you can type in the new 
group name. Add items to the group by click-
ing and dragging them into the new group box. 

Make changes to a group 
by clicking the three lit-
tle dots in the top right 
corner of the group. This 
will pop open a menu 
that gives you the op-
tions to copy the group, 
move the group, rename 
the group, etc. If you 
choose to Delete Group, 
it will not delete the indi-
vidual items inside the group. If you choose to 
Delete Group and Contents, it will delete both 
the group AND its contents. 

We’re viewing the panel by Group 
and clicked the plus sign (circled) 
to create a new group, which you 
can see near the top of the panel.

Click the three dots 
to the right of a group 
name to access differ-
ent edit options.
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Unlinking Items from the Cloud (21:41)

So what do you do if you no longer want 
a graphic to be linked to the version that’s 
in the cloud? This could be the case if you 
want to make changes to an item in the 
document you’re working on, but you don’t 
want those changes to apply to every doc-
ument the item is contained in. Well there’s 
a special way of placing a graphic so that 
when you place it, it’s no longer linked to the 
cloud. Right-click on the item in the Libraries 
panel and a pop-up menu will appear, giving 
you the option to “Place Copy.” A copy will 
be something that is independent of what’s 
in the Libraries panel and independent of 
what’s stored in the cloud. Therefore, any 
changes you make to it will not be reflected 
in the version within the Libraries panel or in 
the cloud. This works the same for every ap-
plication that has a Libraries panel. You can 
also place a copy by holding down the Op-
tion key (Alt on Win) and dragging the item 
from the panel and into the document. The 
item will still be a smart object, but it will not 
be linked to the cloud. 

If you have already placed an item that has been linked to the cloud, you can still 
opt to convert it to an unlinked version. To do this, make sure that the layer is ac-
tive, click on the Layer menu and choose Smart Objects > Embed Linked. When 
you do this, you’ll see that the icon in the bottom right corner of the layer thumb-
nail switches from being the cloud icon to being the regular smart object icon. 

To place an item from a library into the 
document so that it’s no longer linked 
to the cloud, right-click on the item and 
choose Place Copy.
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In InDesign, You can also take a graphic that has been placed from the Libraries 
panel and you can unlink it from the cloud. To do this, right-click on the link (with-
in the Links panel) and choose Unembed Link from the pop-up menu. You’ll be 
prompted to specify a location on your hard drive for the new unlinked graphic 
to be saved. 

Quickly add multiple items to a library (27:22)

There are instances where you may need to save several different items to one 
of your libraries. This could be the case if you have a document that contains a 
series of corporate logos, colors, fonts, etc. There are two different ways of doing 
this. To add an element from the active layer to your Library, click on the plus icon 
( + ) at the bottom of the Libraries panel. A menu will pop up, giving you a list 
of items relating to the layer (Color, Character Style, Graphic, etc.) and you can 
choose which of these to add to the Library.

If you’d like to create a new library 
from multiple different elements from 
the document (not just a single layer), 
click on the icon that looks like two 
lines with an upward pointing arrow 
at the bottom of the Libraries panel. 
This will open a dialog and Photoshop 
will look at the current document and 
ask you which of the properties you’d 
like to save into your library. The prop-
erties listed are the ones that Photo-
shop thinks are important and these 
could include character styles, layer 
styles, colors, etc. Select the desired 
assets from the dialog and then click 
the “Create New Library” button at the 
bottom of the dialog. 

Here, we’re creating a new library based on 
the elements in the document. We’ll check all 
the elements we want to be added and then 
click the “Create New Library” button.
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The new library will appear in the Libraries panel and you can continue to fine-
tune it. If the library was created from a complex document, there may be a lot 
of unnecessary elements that you may want to remove in order to clean up the 
library. In the video example, it added the foreground/background colors of white 
and black to the library. I found these to be unnecessary so I deleted them. I also 
ended up with several versions of the same font, so I deleted all but one in order 
to tidy up the library. 

If there were a lot of layer styles added to the library, you may want to click 
through them so you can see what each one is doing. Then decide if you want to 
keep all of them in the library or if you want to remove some. When a layer style 
is automatically added to a library like this, it takes the name of the layer it was 
applied to and adds the word “style.” This isn’t always the best naming system 
because it’s not truly telling you what the style is doing. I like to rename these 
styles to better reflect their purposes. 

In the video example, it added all of the styles to the library, but it didn’t add the 
graphics. I’d like to add the graphic that looks like a magnifying glass with some 
stars next to it so I will select the two layers that make up that graphic and I’ll drag 
the graphic into the Libraries panel. 

You may want to take the elements 
from the current document and 
then add them to a different library 
that you have already created. Af-
ter creating the library based on 
the document, select the elements 
you would like to move, right-click 
on them and a menu will appear. 
From that menu, choose “Move 
Selected Items To.” A list of your 
other libraries will appear and you 
can choose the one you’d like the 
items to be moved to. 

We selected some elements from the library, right-
clicked on them and are choosing to move them to 
a different library.
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You can delete an entire library by clicking on the hamburger menu in the top 
right corner of the Libraries panel and choosing “Delete *library name*.”

More Libraries Panel Features (35:25)

Bottom icons There is a number on the bottom right side of the Libraries panel 
and that number will change from one library to another. It represents the amount 
of space that the library is taking up in your Creative Cloud account.  The icon to 
the right of the number is the Creative Cloud icon. If, instead, it looks like two ar-
rows moving in a circle, it means that it’s actively syncing the current library with 
your Creative Cloud account. The icon on the far right is the trash can icon and 
you can click this to delete a selected element from the current library. 

Tool Tips Tool tips are little boxes that 
pop up when you hover your cursor 
over a particular item. They can be 
found throughout Photoshop as well 
as in the Libraries panel. If you hov-
er your cursor over one of the library 
items, a box will temporarily pop up, 
giving you some information about 
the item (file size, name, the program 
it was created with, etc.). 

We already discussed that the View 
By menu can be used to determine 
whether the Libraries panel should 
categorize the elements by Type or 
by Group. The two icons to the right 
of this menu allow you to decide whether the items should be displayed as a list 
or as a grid of thumbnails. When viewing the items as thumbnails, the names of 
the items should appear below the thumbnails. If they don’t, click on the ham-
burger menu at the top of the panel and choose to “Always Show Names.” 

Hover the cursor over a library item and a tool 
tip will appear, providing additional info.

These icons determine whether you’re viewing 
items as thumbnails or as a list.



CC Libraries © Ben Willmore, All rights reserved 13

Sharing Libraries (38:29) 

The menu at the top of the panel 
contains a list of all your libraries. 
You may find that some of the li-
braries have a little icon to the left 
of their name. That’s because you 
can share a library amongst oth-
er people (as long as they have an 
Adobe ID). 

To share a library with someone, 
click on the hamburger menu at 
the top of the Libraries panel and 
choose Collaborate or Share Link.

Collaborate  If you choose to “Col-
laborate,” it’s going to take you to 
http://assets.adobe.com and this 
is where you can manage all your 
libraries. An invite box will appear, 
where you can enter the email for 
the person you want to collaborate 
with. You can also use the menu at 
the bottom of the box to determine 
whether the person will be able to 
edit the library. If you choose “Can 
edit,” it means that the person can 
change, add or delete items from 
the library. If you choose “Can view,” 
it means that the person can see 
and use the items, but can’t make 
changes. 

The people icons indicate that these are shared 
libraries.

This is the box you’d fill out to invite someone to 
collaborate. Use the menu at the bottom to speci-
fy whether they can edit the library or just view it.
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Click the Invite button and the person will receive an email that contains a link 
which will take them to http://assets.adobe.com. They’ll be prompted to sign in 
with their Adobe ID and accept the invitation. When they accept, the library will 
appear within their Libraries panel. 

You can always change whether or not the collaborator can edit the library by 
viewing the library at http://assets.adobe.com and changing the settings for it. 

Share Link If you choose to share 
a library with someone via the 
Share Link option from the ham-
burger menu, you will be given a 
URL that you can copy and send 
to someone else. Anyone who 
receives this web address will be 
able to view the contents of the 
library. This is the method you’d 
use if you want to share a library 
with a large amount of people.

 

Additional Menu Features (42:57)

Importing and Exporting Libraries The hamburger menu contains options for 
importing and exporting libraries. If you choose to export the library, it will create 
a file on your hard drive that contains the contents of that library. You could use 
this file as a backup or you could send it to someone else. To import a library that 
someone else exported, click on the hamburger menu at the top of the Libraries 
panel and choose Import. You’ll be prompted to navigate to the location of the 
file on your hard drive. 

View on Website This is another option within the hamburger menu. Choosing 
it will cause the library to open within http://assets.adobe.com. You can manage 
the library from here if you’d like.

If you choose to share link, this box will appear, 
which includes the link you can send to others.
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View Deleted Items This option would also take you to the assets website and it 
will take you to the section that contains all of your deleted items. 

Learn more The Learn More and What’s New options will take you to Adobe’s 
website so that you can access some additional tutorials on the Libraries panel 
features. 

Drag and Drop for Adding Many Files to a Library (7:06)

Sometimes, you may want to add a large number of graphics to a library. One way 
of doing this is by dragging files from your hard drive directly into your Libraries 
panel. You can also add multiple files to a library from within Bridge. Bridge also 
has a Libraries panel. If it’s not currently open, you can access it by clicking on the 
Window menu and choosing Libraries Panel. With the panel open, you can drag 
multiple files into a library from within Bridge. 

Here, we are in Bridge, dragging files from the main window into the Libraries panel.
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Using Libraries to Share Files (47:55)

You can use shared libraries for simply sharing files back and forth (instead of 
using email, Dropbox, etc.). When the file appears in your library, you can place it 
into your document as a smart object or you could right-click on the document 
and choose “Edit.” This will open the file in its own window and you can save it as 
you choose. 

Extra Tips (50:09) 

Search Libraries There is a search field at the top of the Libraries panel and you 
can use this to search for specific items within your libraries.

Add note Any time you need to add more detail about an item, you can right-
click on it and choose to “Add Note.” This will allow you to add up to 130 charac-
ters of text to the item info. When you use the search field, it will search within 
the notes as well. 

 


